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Greetings Aviation Chapter Members!

I hope everyone is prepared for the holidays, and is getting out to enjoy the Christmas 
lights!  I’m happy to report that we were able to successfully complete our Christmas 
Angels project again this year –  a big THANK YOU to Tammy Pendergast for organizing 
the project and to all our wonderful volunteers who helped by purchasing gifts and gift 
cards to help support families in need.  

As mentioned in our previous newsletter, we are in the initial planning stages for a virtual 
Mini-PDI.  If anyone is interested in helping plan the event, please let me know.  See 
below for some additional local and national ASMC news:

*We’re always looking for speakers – please let us know if you have a suggestion for a
topic or speaker for future meetings.

*National has released the Virtual PDI 2020, with 28.5 CPEs offered at no cost to ASMC
members.  Go to https://asmconline.org/pd/virtual-pdi/ to register (make sure your
membership is up-to-date first!).  FREE CPE!!

*National is offering a live, instructor-led, virtual Fiscal Law course via Zoom on 25-27
January 2021 – 24 hours CPE!  This course costs $480 for members/$520 for non-
members and you can register at: https://asmconline.org/pd/training/fal/purpose-time-
amount-fiscal-law-training-3-day-course/

*The December Tips and Tricks provided by TekSouth will be on 17 Dec, at 10:00 ET or
15:00 ET (one hour).  Mr. Rich Brooks will be presenting at this month’s sessions. He will
be using some magical formulas and operations in Excel, Power Query, Pivot Tables, and
Power BI to categorize Date Buckets of data.  The sessions are free, but you must register
at https://www.teksouth.com/vtt-reg/ if you’d like to attend.

*National is having a monthly drawing for members who renew on-time or early – so
remember to check when your membership expires.

Twitter: @asmctweets
Facebook: www.facebook/pages/American-Society-of-Military-Comptrollers 
Website: http://www.asmc-aviation.org/

Chapter President  

Sheena Fast 
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President's Message Cont'd
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*The Chapter is still looking for volunteers for a few open positions, to include Professional Development Co-Chair,
Awards Chair, Ways and Means Chair, and Programs Co-Chair.  Please contact me or your organizational VP if you’d like
to volunteer or have any questions about the positions.  This is a great opportunity to get involved with our organization!
See below for the responsibilities of each of these positions/committees.

• Professional Development Committee shall be responsible for advancing the training and education of the
Chapter membership. Specifically, this Committee shall establish education and training goals for the Chapter; plan, 
coordinate and arrange any seminars, training sessions or classes conducted by the Chapter; and accomplish other 
educational activities as directed by the Executive Board to include mini-PDIs. This Committee shall serve as liaison 
between the Chapter, ASMC National Headquarters, and the Host Chapter for all matters relating to the ASMC National 
PDI. When this Chapter shall participate as Host, and/or co-Host, for a national PDI, the Committee shall be responsible 
for planning and programming of such events.

• Programs Committee shall arrange, schedule, and coordinate chapter meetings and social affairs. This
Committee shall also be responsible for printing, distributing, and controlling tickets for the monthly meetings. This 
committee shall coordinate its activities with both the Communications and Ways and Means Committees. A specific 
function of the Program Committee shall be to obtain qualified speakers for Chapter meetings.

• Awards Committee shall be responsible for soliciting nominees for chapter awards and making
recommendations to the Executive Board on proposed winners.  All Chapters nominees will be forwarded to the 
National Office for consideration for the award at the national level.  

• Ways and Means Committee shall be responsible for raising funds to achieve specific Chapter objectives.
Activities of this committee shall be coordinated with both the Program and Communications Committees. 

I encourage everyone to find ways to be active within our Chapter, by joining a committee, calling into our virtual 
presentations, and/or attending Chapter events.  Wishing everyone a Merry Christmas and Happy New Year!

Sheena Fast
President, Aviation Chapter 
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Upcoming Member Meetings: 

MONTHLY MEMBER MEETING 

Mr. George Diehl, AFMC/FMC, presented Basics And Best Practices For Your Home Network on 24 
Nov.  George presented basic networking concepts, discussed some best practices, and provided 
information which could save you money.  The complete presentation can be found at - 

https://www.asmc-aviation.org/wp-content/uploads/2020/11/Home-Networking-and-Best-ractices_v7.pptx

November Member Meeting

December 22 Zoom Trivia Virtual social event
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Congratulations

Tim Edem retiring 31 December 2020 after 16+ years of Civil Service and after 25+ years of active duty.  He wishes all the 
best to our Aviation Chapter of ASMC and our USAF.

MSgt Matthew Glassburn, AFMC/FM, has been selected for First Sergeant,

Christmas Angels 2020

The ASMC Aviation Chapter in conjunction with the American Legion Unit 776 sponsored the annual Christmas Angels 
project. Even though we had to do things a little differently this year, the ASMC Aviation Chapter members went over 
the top and were able to support all of our angels.  The Christmas Angels consist of families turned in from employees at 
WPAFB, children in protective custody (CASA - Court Appointed Special Advocates for Children), Montgomery County 
Children Services and emergency families who have lost their home due to fire, etc., or have had a catastrophic event 
happen right before Christmas.

Thanks to everyone who made our Christmas Angels such a success again this year.  
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Training Resource: Budget Line of Business

Are you looking for additional training resources and tools? Check out the Budget Line of Business (BLoB). The BLoB offers 
dozens of courses each year on a variety of budget, technology, and career development topics, including budget 
formulation and execution, introductory and advanced Excel, and leadership development.

What is the BLoB? The BLoB is a partnership between the Program Management Office that is housed at the Department of 
Education, the Budget Systems Branch at the Office of Management and Budget, and 27 partner agency budget offices. The 
BLoB was formally launched in 2006 as a means to support the federal budget community by examining commonalities and 
complexities in agency processes. The BLoB goal is to develop modern, adaptable, and cost effective solutions for the federal 
budget community’s process, technology, training, and career development needs. The Department of Defense (DoD) is one 
of the 27 partner agencies, and all members of the financial management (FM) workforce are encouraged to participate in 
the initiatives led by the BLoB.

Since 2007, the BLoB has offered 278 (and counting) training opportunities, which are open to the entire federal government 
budget community, and include events such as budget process workgroups, monthly task force meetings, and 25 forums and 
conferences. The DoD FM workforce is encouraged to take advantage of these BLoB training offerings, which have been 
attended by hundreds of DoD employees over the past 13 years. Two major events held annually by the BLoB, the spring and 
fall forums, have historically been available to individuals in the National Capital Region. Due to recent world events, the 
spring forum was opened to the entire DoD workforce. As you would imagine, DoD participation in this event increased 
significantly. Many of the training and development opportunities offered by the BLoB are eligible for DoD FM Certification
Program Continuing Education Training (CET) credits; one of the many advantages of participation. Documentation for 
completion of this training is met through a Memorandum For Record from your supervisor. In addition to CET credits and 
personal development, attendees also have the opportunity to learn about budget challenges across the federal government 
and to expand their peer networks.

The BLoB newsletter is the best way to stay up-to-date on what’s going on across the budget community; it provides timely 
information on recent budget news and resources for budgeteers. For more information on how to sign-up for the BLoB 
newsletters, please visit: go.max.gov/budgetlob/communications.

To access the full portfolio of BLoB tools and resources, please visit the MAX.gov homepage: go.max.gov/budgetlob



TREASURERS’ REPORT/CHAPTER CALENDAR 

TREASURER’S REPORT 

October 2020 

Treasurers:  Dawn O'Connell and Rebecca Workman 

Note:  
The Fidelity ending balances are 31 October 2020. The Fidelity 
account balances are investments and fluctuate with the market.  
This causes unrealized gains and losses, which are captured in 
the Income.

Aviation Chapter Calendar 
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Dec 22 Zoom Trivia Virtual social event 

Telling a Story - Michael BrameJan 21



COMPUTER TIPS and TRICKS by GEORGE DIEHL 

Excel Table Format

We are all familiar with creating data and information in Excel. When we do this, we are generally working with normal 
Excel Ranges. However, Excel does have a special table format. This format is what I refer to as the Excel Table Format 
which is a very special type of named range. Below I provide some highlights of the benefits to this format. This article, 
while old, is still relevant and does a nice job of breaking down the key features of an Excel Table.

Once you have your data in an Excel sheet, select it and click on the Format as Table dropdown in the Home tab of the 
ribbon and select a Table style. This will open the “Format As Table” window to verify the data range and whether or 
not you have headers. Headers are required for an Excel Table so Excel will insert them automatically as Column 1, 
Column 2, etc. if you do not have any. Now you have a table formatted as an Excel Table. 

By default, an Excel Table will have filters. An important note is that you can only have one active filter per sheet where 
you can have multiple tables per sheet. Additionally, you will have a Design tab in the ribbon which provides some 
useful options (e.g., quick Table Styles, banded rows/columns, first/last column, and total row). Excel Tables also enable 
you to make use of data connections and the data model in a way that is similar to Pivot Tables. Excel Tables are 
dynamic and will expand it by adding new rows when data is entered in the row below it. Additionally, when a new 
header is added to the right of the Table, it will be included in the table. Formulas can be automatically filled as well. 

As a word of caution, Excel Tables have their own type of references which tend to throw users off. If you reference a 
cell in table while in the same row (e.g., B2), you will see something different (e.g., [@Column 1], Table1[@Column 1]. 
Similarly, an entire column will be referenced as [Column 1] or Table1[Column 1] instead of B2:B123. Ultimately, this 
new nomenclature is very useful when formulas are being used within an Excel Table. However, this nomenclature does 
take a little getting used to. 

Excel Slicers

A great feature for Excel Tables and Pivot Tables is the Table Slicer. This feature is effectively a filter object which can 
make it easier to apply and track multiple filters to a dataset. Select a Table, or simply a cell within it. Click on the Insert 
Slicer in the Design tab of the ribbon. Alternatively, the Slicer button can always be found in the Insert tab. After clicking 
the button, the Insert Slicers window, which contains a list of the headers in your Table, will appear. For each header 
you select, a small filter object will appear. These Slicers contain a list of all the unique entries in that column. You can 
now filter your data by selecting items in these Slicers versus clicking on the little dropdown and selecting the items. 
Hold Ctrl to make multiple selections. In short, this is a more visual and quicker method to apply filters when exploring 
data. To remove a slicer, click on it and press the Delete key or right click on the Slicer and select remove. With a Slicer 
selected, an Options tab will be available in the ribbon where a variety of formatting options are available. Here is a link 
to use them in tables and here is a link to use them in pivot tables for some more examples. 

Remove Table Formatting in Excel

Tables in Excel are very handy. However, there may be a time when you come across a table that you would like to 
remove the Excel Table formatting. This can quickly done by converting the Table back into a Range. To remove Excel’s 
table formatting from a range of cells, select a cell within the table. In the Design tab, a “Convert to Range” button on 
the left-hand side in the “Tools” group of buttons is available. Clicking “Convert to Range” will open a prompt asking if 
you want “convert the table to a normal range”. Clicking “Yes” will convert the Table into a Range. Keep in mind, the 
style (i.e., banded rows, colors, and general formatting) will be retained but all of the Table features will be no longer be 
available.
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COMPUTER TIPS and TRICKS by GEORGE DIEHL 

Excel Table and Filter Keyboard Shortcuts

Note: Some of these shortcuts behave differently when a Table or Range is selected. The list below will indicate the 
different behavior when applicable.

Ctrl+T and Ctrl+L will open the “Create Table” dialog box for the selected range. 

Ctrl+Spacebar will select the entire column for the selected range. Pressing it a second time will also select the column 
header(s). A third time will select the whole column for the entire sheet.

Shift+Spacebar will select the entire row for the selected range. Pressing it a second time will also select the entire 
row(s) for the entire sheet.

Ctrl+A will select all of the cells in the table except the headers. Pressing it a second time will also the headers. A third 
time will select the entire sheet. 

Ctrl+Shift++ will insert a new row above the selected row(s) within a table. Pressing it when the selected range is not a 
table will open the Insert window.

Ctrl+- will delete the selected row(s) within a table. Pressing it when the selected range is not a table will open the 
Delete window.

Ctrl+Shift+L will toggle the sheet filter on and off for the selected range, this is the same as going to the Data tab and 
clicking the Filter button. If only a single cell is selected, Excel will attempt to identify the headers.

Ctrl+F3 will open the Name Manager which will show all named ranges with a tag icon and tables with a table icon 
within the Excel workbook. 
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EXECUTIVE BOARD MEETING MINUTES 
ASMC – Aviation Chapter 

Executive Board Meeting Minutes 
19 November 2020 (1000-1100)
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I. President: Sheena Fast called the meeting to order at 10:03 a.m.

II. Attendance/Reports

Treasurers: Rebecca Workman , Dawn O’Connell (A) 
Secretary: JoAnne Wills 
President-Elect: Vacant
Vice-Presidents 
AFAA: Heather Brodess 
AFLCMC: Dawn Holding 
AFMC:  Terri Desch (A)
AFRL: Kristen Wentworth/Helen Barfield 
 At Large: Amy Williams (A)
Contractors: Patrice Solorzano (A)
88th CPTS: Shannon Noles (A)

     Committee Chairs:

Audit: Stephanie Burd, Michelle Hatton 
Augsburg Scholarship: JoAnne Wills 
Awards and Recognition: Vacant
Chapter Competition: JR Frazier 
Communications: Colleen Robinson 
Community Activities: Rhonda Pepitone 
Health & Wellness: Fernando Mason  
Membership: Angela Brown, Cynthia Payne (A), Angela sent out VPs membership lists and 
has received a few corrections back.
Professional Development: Markina McKnight 
Programs: Tammy Pendergast (A)
 Ways & Mean: Vacant 
(A) = In Attendance

III. General Business:

A. OLD:
i. Open positions: Programs Committee co-chair; Professional Development co-chair; Awards

Chair; Secretary; Ways and Means Chair.
ii. Chapter coins:  Need to order a minimum of 100.

iii. National & Local Annual Awards: We will be contacting winners to determine whether they
would like to receive their awards via a formal presentation, a virtual staff meeting, and/or
mailing the award.  Local awards have been picked up, to include boxes for any awards that
need to be mailed.  For the team awards, the individual names are on the team plaque.

1. Cynthia noted that she has pins at the office, if we need them for anything.



EXECUTIVE BOARD MEETING MINUTES 

ASMC – Aviation Chapter 
Executive Board Meeting Minutes 

None Scheduled
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iv. Treasurers need budget inputs for PY 2020-2021 – Committee chairs were asked to provide by COB Weds 4 Nov.
v. Follow up with AFMC concerning President-Elect for PY 2020-2021 – Last month Terri sent email to leadership
regarding the President-elect position, membership, involvement/positions open.
vi. National held an ASMC Chapters Townhall Meeting via Zoom on 10 November at 1200 EST.  Sheena and Tammy
both attended.  The meeting provided some beneficial information both from the National officers and other chapter
attendees. Possibility of using National’s Zoom Professional
vii. Dawn stated that she can help out with setting up/providing info on CVR live.

B. NEW:

i. Next member meetings:
1. 24 November @1130: George Diehl, AFMC/FM
2. December: Virtual Social? Possible trivia.
3. We have speakers booked for January and February.
4. Please let Tammy Pendergast know about any potential speakers.

ii. Dayton Air Show – we need to submit a letter of intent by 31 Dec if we intend to work the vendor booths for the
2021 Air Show (fundraiser).  Not sure of members’ interest, other options: work at Dayton Dragons.
iii. Financial Responsibility – Per AFI 34-223, Private Organizations must have liability insurance unless the Installation
Commander waives the requirement. (T-1) This waiver authority may be delegated to the Mission Support Group
Commander. No further delegations are authorized. (T-1) Insurance should be required unless the activities of the
Private Organization are such that the risk of liability is negligible. {NOTE:  We will be requesting the waiver of liability
insurance.}  Private Organization members must be made aware that they are jointly and severally liable for the
obligations of the Private Organization. The absence of liability insurance places their personal assets immediately at
risk in the event of Private Organization liability.  {NOTE: This is a requirement of the AFI to notify members of their
personal financial liability for obligations of our Private Organization, as provided by law.  We will also brief this at our
next membership meeting, and include in the next newsletter.}
iv. Volunteers to fill positions:

1. ???
v. Mini-PDI – virtual event. Need to set up meeting for planning.
vi. Future socials – discussed holding a virtual social (i.e. via Zoom) to help get more people involved in the chapter.
vii. Meeting adjourned at 10:45.



ASMC honors America’s Veterans

Veterans Day honors the sacrifices military men and women throughout the centuries have made in service to our 
country.  In war and peace, these warriors have guarded our shores, provided aid and assistance to American citizens 
throughout the world, and fought for the freedom of nations and of peoples.

Thank you to our Veterans, Active Duty, Retired and Reserve military for your service to the United States.  We are 
proud of and grateful for all you have given and accomplished.

Webinars

ASMC is proud to offer live webinars in Defense Financial Management, leadership and teamwork, and personal 
development!  Webinars will be offered as 1 or 2 hour sessions with registration open to both members and non-
members alike.  The next scheduled webinar is Thursday, January 7, 2021, on Superior Customer Service.  To learn 
more visit - https://asmconline.org/pd/webinars/

ASMC NATIONAL PROGRAM NEWS
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Ms. Sheena Fast
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Ms. Susan Duening
Ms. Rebecca Workman; Ms. Dawn O’Connell 

Organizational Vice Presidents 
Ms. Shannon Noles 

Ms. Heather Brodess
Ms. Terri Desch 

Ms. Kristen Wentworth; Ms. Helen Barfield
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Ms. Patrice Solorzano
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AFRL VP 
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Contractor VP 
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Chapter CompeƟƟon 
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Ms. JoAnne Wills 
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